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Example — Offshore structure
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Objective:

Display the deflection figure and
von Mises stress distribution
Tasks:

Import geometry from IGES.
Display the deflection figure?
Display the von Mises stress
distribution?

E = 210000N/mm?
v =0.3
F = -10000



Example — Offshore structure
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Example — Import IGES

Utility Menu > File > Import > IGES

Clear & Start Mew ..,
Change Jobname ...

Change Directary ... mIITIDDI't IGES File

Change Title ...
[AaL15] [IOPTM] Options for IGES Import

Iges Import Optian
Resume fram ... | Ty

Fesume Jobnarme.db ...

Save as Jobname.db e
Save as ...

Write DB log file ... MERGE Merge coincident keypts? W ves

Read Input from SCLID Create solid if applicable ¥ ves

Sweitch Outout to r SMaLL Delete small areas? ¥ ‘es

List »

File Cperations g

AMSYS File Options ...
oK @ Cancel | Help |

IGES.. e

Export ... (B

Report Generator ... SRl
Fro/E ...

Exit ... Uz .. - PI’ESS OK
SAT ...
FaRA ...
HEAL ...

ANSYS CIF Example0153
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Example — Import IGES

I\ Import IGES File x|

GTOLER Tolerance for merging IUSE default j

[IGESIN] (AUX15) File to irmport K Browse. . |

_‘ Ok | Caﬂceu Help |

— Browse to find offshore-structure-skeleton.igs

Press OK — : .
' Because no areas have been imported, automatic volume creation is
« ) suppressed.
Close
ANSYS Example0153 )
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Example - Display

: , r— J

FEE 15 =004
20: 36132

TYPE NITM

AR EAELE

Select
Front View

.@EBEEEEEE@EE@EE@L'
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Example - Numbering

File Select List Plot PlotCirls \WorkPlane Parameters Macro MenuCirls  Help

Fan Zoom Rotate ...
Yiew Settings

Mumbering ...
Symbals ...
Style

Font Controls
Window Controls
Erase Cptions

animate
Annotation

Device Optians ...
Redirect Plots
Hard Copy

li\Plot Numbering Controls
[/PHUM] Plot Mumbering Controls

KFP  Keypoint numbers
LIME Line numbers

AREA Area numbers

YOLU Yolume numbers

NODE Mode numbers

Elem / Attrib numbering

TABM Table Names

SWaL Mumeric comtour values

X
I~ off @
I off )
[~ Off
[~ Off
o

IND numbering
I~ off

[ Off

Save Plot Cirls ...
Restore Plot Cirls ...
Feset Plot Cirls

[AUM] Mumbering shown with

ICDIDrs 2 nurmbgrs ;j

Capture Image ...
Festore Image ...
Wirite Metafile

[/REPLCT] Feplot upon Ok fApply?

Apply |

Ik I

IRepIDt

Cancel I

Multi-Plot Confrals ...
RAL =Y inclone Layout

ANSYS
Computational Mechanics;

Best Quality Image

Yo, U TTyY

Set Keypoint numbers On —
Set Line numbers On
Fxample0153




Example - Numbering

ANSYS

FEE 15 zZ004
16:54: 28
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Example — Element Type

Preprocessor > Element Type > Add/Edit/Delete

Element Types j x|
- x = =
Defined Element Types: fA\Library of Element Types x|
MOMNE DEFINED Library of Element Types Structural Mass 5=
Link: [ tee 17
Bearn elbow 18
Plast straight20
elbow 60 -
Elast straight1s

Element type reference number

04 | Aoy | Cancel | Help |

Add... |e Sptions- Selete Press Add
Clase | Help |
ANSYS Example0153 9

Computational Mechanics, AAU, Esbjerg



Example - Element Type

Preprocessor > Element Type > Add/Edit/Delete

I\PIPE16 element type options x|
Options for PIFELS, Element Type Ref. Mo, 1

Temperatures represent k1

Defined Element Types:

el Stress int factors (SIF) from K2 IReal con SIF 18] j
Element id in output K IStraight pipe j
Use of P¥, PY, PZ pressures K5 IUSE normal comp j
Member force + maoment output KB IE}{l:Iude outpLEt j
Gyroscopic damping matrix K7 IN':' matrix j

Ok | Cancel | Heln |.

Add... Options. .. |0 Balete Press Options
| |
_ckse | _teb_| Press Help to learn more about the |
element.
ANSYS Example0153 10
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Example — Real Constants

Preprocessor > Real Constants > Add
Real Constants

Defined Feal Constant Sets

MOME DEFIMED

X

Add... @

=1L
L | | R

trelete |

Close |

Help |

ANSYS

Element Type for Real Col

Choose element type:

Type 1 PIPE1E

04 ®

Cancel

Place the cursor
on the relevant
element and
press OK

Example0153
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Example - Real Constants

Preprocessor > Real Constants > Add

I\Real Constant Set Number 1, |
Elernent Type Reference Mo, 1
Real Constant Set Mo.

Real Constants 1

Enter OD=60 and TKWALL=3 —|_. Defined Real Constant Sets

Cutside diameter oo
Wzl thickness TEMYALL
Stress intensity fact at I SIFI

Stress intensity fact at 1 SIF]

Set 2
Enter OD=26 and TKWALL=2 —® ¢ i

Set
Enter OD=30 and TKWALL=2 —|_.

Enter OD=40 and TKWALL=3 —

TS

X

Flexibility factor FLEX
Internal fluid density  DEMSFL
Ext insulation density  DENSIM Add 4 Sets
Insulation thickness TEIM
Corrosion thi allowance  TECORR
Insulation surface area  AREAIN
Fipe wall mass MibfaL L PreSS C|OS€ L @ Add... | Edit... | Dielate |
Axial pipe stiffness SHEE ..
Rotordynamic spin SPIM to fl nISh
| ® Close | Help |
oK @ | Apply Cancel | Help |
Fress OK
ANSYS Example0153 12
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Example - Material Properties

Preprocessor > Material Props > Material Models
I\Define Material Model Behavior

wWaterial  Edit Help

— Material Models Defined

o]

Double Click
to step in the

— Material Models Available mate”al tree
& Material Model Nurmber 1 ] ﬁ Structural =]
@ Linear
8 Elastic
@ [sofropicll g
€ Orthotropic
@ anisotro [T, Isotropic Properties for Material N X|
Monlinear
© Density Linear Isofropic Material Properties for Material Murmber 1
Thermal Expansior
€ Damping -
| 8 Friction Coefficient
= ] | Temperatures I
femn | e BA=dmwri= ] Teie
‘ ILI_‘ | EX
PR
Add Temperature | Delete Temperature Graph
k. Cancel Help
ANSYS Example0153 13
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Example - Material Properties

Preprocessor > Material Props > Material Models

: Click here
Linear Isotropic Properties for Material [ x| Enter- CI
Modulus of elasticity to Close
Linear Isotropic Material Properties for Material Mumber 1
Enter:
. , .
S S Poisson’s ratio
Temperatures
Ex 210000 o
PRCY 4 N.YDefine Material Model Behavior 0| x|
Material Edit Help
— Material Madels Defined — Material Madels Available
& Material Model Nurnber 1 izl @8 Structural =]
add Temperature | Delete Temperature | & Linear Isotropic &8 Linear
8 Elastic
® Ok | Cani
€ Orthotropic
& Anisofrapic
Monlinear |
& Density
Thermal Expansion Coef
# Darmping
PI’ESS OK - = @ Friction Coefficient
= (e | e B = im] Cumieane B
1 | » 1| | v
ANSYS Example0153
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Example — Mesh Attributes

Preprocessor > Meshing > Mesh Attributes > Line Attributes > Picked Lines

Select Line L7, L1, L8

% pick @ Hmpick

{* Single ( Box lilLine Attributes _ X

O Polygon (" Circle [LATT] Assign Atiributes to Picked Lines
i Loop
MAT  Material number I 1 j
Count = 1
i REAL Real constant set number I 1 j
finimam = 1 TYPE Element type number I 1 PIFE1G d
Line MHo. = 1
SECT Element section e
{* Lizt of Items INDFIE s llal J
Pick Crientation Keypaint(s) [ Mo

- Min, Max, Inc

0E @ Apply

Reset Cancel

Pick all Help Ok | Apply | Cancel | Help |

ANSYs —— Press OK —— Example0153 15
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Example — Mesh Attributes

1
LINES

LINE NTH

ANSYS Example0153
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Example — Mesh Attributes

Preprocessor > Meshing > Mesh Attributes > Line Attributes > Picked Lines

Line Attribute

% pick @ Hmpick

i+ Bingle i~ Box

" Polygon {" Circle

& Change to 2

.

Count
Maximuam

1
z
Minimam 1
1

Line No.

{¥ List of Items

- Min, Max, Inc

0E @ Apply

Deset Cancel

Pick All Help
ANSYS—— Press OK ——

Select Line L5, L4, L6

filLine Attributes _ X|

[LATT] Assign Atributes to Picked Lines

MAT  Material number

1

FEAL Real constant set number

El
El

TYPE Element type number

|
| 2
| 1 FrFELS ~|

SECT Element section

Pick Crientation Keypaint(s)

INDHE defined j
[T Mo

4 | dpphy | Cancel | Help |

Example0153
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Example — Mesh Attributes

1
LINES

LINE NTH

ANSYS Example0153
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Example — Mesh Attributes

Preprocessor > Meshing > Mesh Attributes > Line Attributes > Picked Lines
Line Atiribute Select Line L2

% pick @ Hmpick

{* Single ( Box lilLine Attributes _ X

O Polygon (" Circle [LATT] Assign Atiributes to Picked Lines
& Change to 3
MAT  Material number I 1 j
Count = 1
i \—0 REAL Real constant set number I 3 j
finimam = 1 TYPE Element type number I 1 PIFE1G d
Line MHo. = 1
SECT Element section e
{* Lizt of Items INDFIE s llal J
Pick Crientation Keypaint(s) [ Mo

- Min, Max, Inc

0E @ Apply

Reset Cancel

Pick all Help Ok | Apply | Cancel | Help |

ANSYs —— Press OK —— Example0153 19
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Example — Mesh Attributes

1
LINES

LINE NTH

ANSYS Example0153
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Example — Mesh Attributes

Preprocessor > Meshing > Mesh Attributes > Line Attributes > Picked Lines

Line Attribute

% pick @ Hmpick

i+ Bingle i~ Box

" Polygon {" Circle

& Change to 4

.

Count
Maximuam

1
z
Minimam 1
1

Line No.

{¥ List of Items

- Min, Max, Inc

0E @ Apply

Deset Cancel

Pick All Help
ANSYS—— Press OK ——

Select Line L3

filLine Attributes _ X|

[LATT] Assign Atributes to Picked Lines

MAT  Material number

1

FEAL Real constant set number

El
El

TYPE Element type number

|
| 4
| 1 FrFELS ~|

SECT Element section

Pick Crientation Keypaint(s)

INDHE defined j
[T Mo

4 | dpphy | Cancel | Help |

Example0153
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Example — Mesh Attributes

1
LINES

LINE NTH

ANSYS Example0153
Computational Mechanics, AAU, Esbjerg
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———®

Select/Pick
Lines to

specify
mesh size
for

ANSYS

Example - Meshing

Preprocessor > Meshing > Size Cntrls > ManualSize > Lines > Picked Lines

Element Size Element Sizes on Picked Lines X|
o i [LESIZE] Element sizes on picked lines
SIFE Element edge length I
(o Single " Box g ——
C Polveon  cirele MDIV  Mo. of element divisions ‘ *——
" Loop (MDIV is used only if SIZE is blank or zero)
KYNDIV SIZE,NDIV can be changed ¥ Yes
Count = u}
Maximum = 1 SPACE Spacing ratio I
Minimum = 1
_ ANGSIZ Division arc (degrees) I
Line MNo. =
( use ANGSIZ only if number of divisions (NDIV) and
{* Lizt of Items element edge length (SIZE) are blank or zerao)
" Min, Max, Inc Clear attached areas and volumes ™ Mo
Enter
Sl _ ok | Aoply _cncel | | 2 for L7
Reset Canpel | 3 for L6
Pick All Hellp | 4 for Ll,l_4,|_5
—— Press OK when finish with selection | 2 for L8
Example0153 23
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Example - Meshing

Preprocessor > Meshing > Mesh > Lines

% tick @

g e P
L2 UIIEITE

[ Single {" Box ‘

" Polygon {" Circle

o Select individual lines to be meshed by Picking

Count = I

Maximam

Minimam

Line Ho.

NB: It is often necessary to “Clear” the model for
R example if Element Type is to be changed

- Min, Max, Inc

Select all lines defined to be meshed

OE Lpply
Beset Cencel
Bick 211 Help
[ )
ANSYS

Example0153 24
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Example — Size and Shape

Size and Shape x|

Pan Zoom Rotate ...

. [/SHRIME] Shrink entities by 0 percent
Yiew Settings
4 [/ESHAPE] Display of elerment M of e
Numbering ... shapes based on real
Symbols ... constant descriptions
Hidden Line Cptions ... SCALE Real constant multiplier Iu
Size and Shape i @
Font Controls "’ Edlge Optiunsp [/EFACET] Farets/element edge | 1 facet/edge =l
Window Contrals *
i [/RATIO] Distortion of Geormetry
Erase Options * Contours + :
e , W Window nurmber Iwmdgw 1 j
animate 5 e : RATOX ¥ distortion ratio | 1
- 3
ATTEEIEN RATOY Y distortion ratio | 1
_ _ Light Source
Dew.ce Options ... X Translucency » [/CFORMAT] Component/Parameter Format
REdE'I"E':t Flots | Texturing : NFIRST, MLAST Widths [32 E
Hard Copy
S Background b [/REPLOT] Replot upon Ok Aapply? IRepIu:nt j
ave Plo S
S e Multilegend Cptions »
=emet Bl il Flaating Point Format ...
R e Displacement Scaling ...
Rezb:lre Imalje Yector Arrow Scaling ...
Write Metafile * Shell Mormals ... |
Multi-Plot Controls Solid Made| Facets .. = sy || e e
L= indome Layout AR :

_ Press OK — Switch to On
Best Quality Image »

ANSYS Example0153 25
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Example — Display of element

1
LINES

LINE NITM

ANSYS Example0153
Computational Mechanics, AAU, Esbjerg
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Example — Analysis Type

Write Database Log :

Wiite D atabase Log to Directories:
i @ o hadminiztrator
Cancel |
= ot

| [=+ DOCUMEMNTS .&Nj Hel |
E= ADMINISTRATOI P
3 Cookies

3 Dokumenter

LI £ Foretrukne ﬂ
Solution > Analysis Type > New Analysis <t Al

IDatahase Log [ Igw] ;I I = ;I MHetwark. .. |
m New Ana I?ISis | EI I'W'rite non-ezzential cmds as comments LI

[ANTYPE] Type of analysis

File > Write DB log file
Enter “example0153.Igw”

k

" Modal

" Harmonic
" Transient
" Spectrum

" Eigen Buckling
" Substructuring PreSS OK

oK @& Eateel Help |

ANSYS Example0153 27
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Example — Define Loads

Solution > Define Loads > Apply > Structural > Displacement > On Lines

Apply UROT

Select line L7, L1, L8

Select UX

¥ pick @&— ik
I Apply UROT on Lines x|

Qe @ [OL] apply Displacements (LULROT) on Lines

#OEEED () B Lab2 DOFs to be constrained A

i Laoop L

LY

Count = 0 Lz

Maximum = 4 ROTH

Minimum = 1 ROTY

Line Mo. = ROTZ

{* List of Items

all DOF
i Min, Max, Inc
Apply as ICDnstant valLe j
Il YaLUE  Displacement value I
pERe *PPLY oK @ | Apply | Cancel | Help |
Baset Cancel
Pick a1l Help
— Press OK
ANSYS Example0153 28
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Example — Define Loads

Solution > Define Loads > Apply > Structural > Displacement > On Keypoints

Select keypoint 10

¥ pick &— Trpick

Select All DOF

ol ingle {" Box

" Polygon (~ cirele I\ Apply U,ROT on KPs >
ENLLE [OK] Apply Displacements (U,ROT) on Keypoints
P = Labz DOFs to be constrained AIDOFE - @ ¢
Maximum = 2 Ei
FeyP Ho. =
{* List of Items Apply as ICDnstant value j

If Constant value then:

YALUE  Displacement value I

i Min, Max, Inc

| KEXPND Expand disp to nodes? [~ Mo
R :‘:pplx Ok .J apply | Cancel | Help |
Heset Cancel
Pick All Help
— Press OK
ANSYS Example0153 29
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Example — Define Loads

Solution > Define Loads > Apply > Structural > Force/Moment > On Keypoints

Apply F/M on |

@ pick @—Ftrptor—

v 5 ingle { Box

" Polygon { Circle
[ Loop

Count

Maximum

[l [

Minimum

EeyP MNo.

{¥ List of Items

- Min, Max, Inc

Select keypoint 16

Change to FY

Fl\ Apply F/M on KPs ]
[FK] Apply Force/Moment on Keypoints

Lab  Direction of force/mom P I,:x,— T|

Apply as ICnnstant value j

CE @ Eppty
Feset Cancel
Pick A11 Help
ANSYS

If Constant value then:

VALUE Force/moment value I [

oK Tl Apply Cancel |

Press OK to finish Enter -10000

Help |

Example0153 30
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Example — Boundary Conditions

1
LINES

LINE NITH

ANSYS Example0153 31
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Example - Solve

Solution > Solve > Current LS

ANSYS Main Menu @

Preferences

Preprocessor

B Solution
Analysis Type

pml o Solve Current LoadStep x
sty Opts Solve Current Load Step i x|

= rrE"t 5 o [SOLVE] Begin Solution of Current Load Step

From LS Files

Partial Solu Review the summary information in the lister window (entitled
Adaptive Mesh "/STATUS Command"), then press OK to start the solution.
FSI Set Up

ADAMS Connection
Unabridged Menu | e T
General Postproc Ok, Cancel Help
TimeHist Postpro

Topological Opt
ROM Tool
Design Opt
Prob Design
Radiation Opt
Run-Time Stats
Session Editor
Finish

HEREEEHEEBEA

Press OK

o Example0153
Computational Mechanics, AAU, Esbjerg




Example - PostProcessing

General Postproc > Plot Results > Deformed Shape

Plot Deformed Shape | x|

[FLDISF] Flot Deformed Shape
KUND  Items to be plotted

" Def + undeformed @

" Def + undef edge

oK | Apply Cancel | Help |

Select “Def+undeformed”
and Press OK

ANSYS Example0153 33
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Example — Deformed Shape

2y

Lulinuuiiin

ANSYS Example0153
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Example — Contour Plot

I Contour Nodal Solution Data

ANSYS Main Mernu @l [PLMSOL] Contour Modal Solution Data

— Itern,Cornp  Itern to be contoured DOF solution Intensity  SINT =
Preferences =] IS vor Mises  SEQY
Preprocessor Strain-total PlasEqvStrs SEPL

Solution Strain-mech+thrm StressRatio SRAT

B General Postproc
Data & File Opts
Results Summary
Read Results
Failure Criteria KUMD Items ta be plothed
B Plot Results

Deformed Shape

Energy
Strain ener dens
Sirain-elastic

HydrostPres HPRE =

wor Mises  SEQW

= Def shape only

B Contour Plot &+ Def + undeformed
ESIGHET " Def + undef edge
E:Em?:hlgeulu Fact Optional scale factor I 1
Line Elem Res [/EFACET] Interpolation Modes

Yector Plot = Corner only

Plot Path Item

Concrete Plot
List Results Al applicable
Query Results
Options for Outp _
Results Viewer L [&%PRIN] Eff MU for EQY strain |
Write PGR. File
Modal Calcs
Element Table
Path Operations —@ oK Appl Cancel Hel
Py ® o | __eeply_| _carcel | _tep |
Check Elem Shape

" Corner + midside

Write Results
ROM Operations

® Submodeling r Press OK — Select Stress, von Mises SEQV

F Fatirmio

+ ]
ANDT O Example0153 35
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Example — Contour Plot

NODAL SO0LUTION ANSYS

STEEei FEE 15 2004
STE <1 20:21:11
TIME=1

SEQV [AVE)

DI =1. 595

SMN =.798E-14

SM =569, 957

1
.7T98E-14 126,664 253.327 379,991 506,655
63,332 159,995 316,659 443, 323 569,957

ANSYS Example0153
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Example — Comments/Questions

e Could the model be modeled with beam
elements instead of pipe elements?

 The “example0153.Igw” can be edited In
“Notepad”

 Will the number of elements affect the
solution?

ANSYS Example0153 37
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File menu

File Select List Plot PlotCirls \WorkPlane Parameters Macro MenuCirls  Help

Clear & Start Mew ... —
Change Jobname ... You can include commands to be
Change Directory ... executed when the program starts up in ——
izh Title ... .
i the start71.ans file.
BESTE dotaaine al li\Clear Database and Start New
Resume fram ...
Save as Jobname.db [/CLEAR] Clear database and start nemw!
Save as .. Bec stark s gl Lo L
Write DB log file ... @ Read file
" Do not read file
Read Input from ...
Switch Cutput to »
List * x| _ cancel | e |
File Operations 4
dilseile e Clears (zeros out) the database stored in
Impart : memory. Clearing the database has the same
Bt effect as leaving and reentering the ANSYS
Repart Generatar .. program, but does not require you to exit.
/  Exit... Example0153

Computational Mechanics, AAU, Esbjerg
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